# Table of Contents

## General Overview of Temple ERA Proposal Module

Getting Help with ERA ................................................................. 3
Proposal Development in Pre-Award ........................................... 3
Proposal Development Process Flowchart (6 major components) ................................................................. 4

## How do I Login/Navigate the Temple ERA System?

Accessing the ERA System and Navigating the Main Page .......... 5
Searching for a PD/PT Proposal .................................................. 7

## How do I Maintain My Profile?

Updating Contact Information ...................................................... 9
Setting up Delegation by Module .................................................. 10
Viewing My Access Permission Granted by the Investigator ....... 12
Viewing My Investigator’s Proposals or Protocols in ERA as Delegate .................................................. 12
Adding NIH Commons ID in Sponsor Credentials for S2S Submission ........................................... 15
Viewing Training Certifications ..................................................... 16

## How do I Create a PD Proposal?

Creating a S2S (System to System) Proposal (NIH) ..................... 17
Creating a Non-S2S Proposal (using ESPAF) ................................. 28
Understanding Master and Child Records .................................. 36
Creating a Non-Competing Continuation Proposal ....................... 36

## How do I Change the Associated Department of a Proposal?

Changing Proposal Associated Department ............................... 42

## How do I add Personnel and Change PI of a Proposal?

Understanding the Enhanced Personnel Tab ............................... 46
Understanding Personnel Types .................................................. 47
Adding Prime Personnel with Requested Salary .......................... 49
Adding Prime Personnel without Requested Salary ...................... 52
Adding Subaward Personnel ....................................................... 54
Changing the PI of a Proposal ..................................................... 54

## How do I Enter the Budget?

Understanding the Enhanced Budget Model in V15 ...................... 56
Entering Itemized Detail Budget Costs ........................................... 58
Entering Budget - Direct Costs ............................................................................................................................................................... 58
Entering Budget - Indirect Costs ........................................................................................................................................................... 64
Entering Modular Budget (NIH) ................................................................................................................................................................ . 65
Entering a SubAward ................................................................................................................................................................ ...................... 68
Import or Export Grants.Gov Budget Form ........................................................................................................................................... 74
Importing Adobe RR_Budget Form for Subaward ......................................................................................................................... 75
Exporting Adobe RR_Budget Form for Prime .................................................................................................................................. 76
Entering Cost Sharing ..................................................................................................................................................................................... 77
Uploading the budget justification ............................................................................................................................................................ 78
Exporting Budgets ............................................................................................................................................................................................ 78
Budget Setup ................................................................................................................................................................................................ ...... 79
Complete Budget and Build PDF ............................................................................................................................................................. 81

How do I Upload Documents? ................................................................................................................................................................. 82
Uploading Internal Documents for Electronic Routing and Approval .............................................................................................. 82
Uploading Required Internal Documents for Review ........................................................................................................................ 82
Completing the eSPAF for Internal Review ........................................................................................................................................ 83
Uploading documents to an NIH Proposal ........................................................................................................................................ 85

How do I attach protocols in a PD proposal? ........................................................................................................................................ 91

How do I submit a proposal for Internal Review?.................................................................................................................................. 93
Temple Internal Review Requirements and Submission Deadline .................................................................................................. 93
Submitting Proposal for Preliminary Review ...................................................................................................................................... 94
Finalizing and Submitting Proposal for Final Review ...................................................................................................................... 96
Finalizing your S2S Submission ............................................................................................................................................................ 96
Finalizing your Non-S2S Submission ................................................................................................................................................ 100
Reviewing Proposals Using the Online Dashboard .......................................................................................................................... 103
Reviewing the Comments and Resubmitting the Proposal for Approval .......................................................................................... 108

How does PD validate the submission package? ...................................................................................................................................... 110
Attachment Filenames Validation .......................................................................................................................................................... 111
XML Validation ............................................................................................................................................................................................ 113
NIH Commons Validation ........................................................................................................................................................................ 115
General Overview of Temple ERA Proposal Module

Temple Electronic Research Administration (ERA) uses an integrated and automated system to assist research administration activities with both pre- and post-award processes that involves the administrative and regulatory aspects of grants, contracts and clinical trials. For more details, you can visit the ERA website.

Getting Help with ERA

This PD User’s Guide includes all the major components when building a PD proposal in ERA. You can advance through all the sections sequentially or you can jump around from section to section in the Table of Contents. If you encounter any technical issues when using the ERA system for Grant or Contract submissions, please send an email to era@temple.edu with a brief description of the problem along with a proposal number.

Proposal Development in Pre-Award

The proposal development module in ERA provides the following major mechanisms to provide an efficient, collaborative, and secured environment for grant or contract proposals submission for Temple University.

- System-wide reusability of profile and department information.
- Auto populated of University-Wide information (e.g. DNUS#, FWA#) for face page.
- Build/Submit E-Applications with sponsor specific form sets for federal funding agencies (S2S), expect NSF.
- Route proposals and eSPAF for internal approvals and signatures.
- Track/Manage the progress of proposals throughout the entire pre and post-award process.
Proposal Development Process Flowchart (6 major components)

The proposal development process in ERA contains the following major components providing an efficient, collaborative, and secured environment for grant or contract proposals submission for Temple University.

Investigator

- Validate Profile

Investigator or Business Admin

- Create PD Proposal

Investigator or Business Admin

- Submit Pre-Review

Proposal Reviewers

- Internal Review (Department/School)

Investigator or Business Admin

- Submit Final Review

Grants Management Processor

- Submit to Sponsor

**Items to check:**
1. Address – zip+4 is required
2. Name, phone, fax numbers
3. NIH Commons ID
4. Setup Delegation (If applicable)

**Complete Following Tabs:**
1. Setup Questions and Face Page
2. Personnel (CV or Other Support)
3. Abstract
4. Performance Sites with DUNS, Zip+4
5. Budget & Budget Justification
6. Approvals (IRB, ACUC, IBC, EHRS)
7. Temple Docs
   - eSPAF (completed version)
   - Sponsor Guidelines, Required Forms
   - Budget Excel Spreadsheet
   - Temp PI form (if applicable)
   - Subrecipient Commitment Form (if applicable)
   - Subcontracts with scope of work, LOI, budget and Justification (if applicable)

All tabs within the application need to be checked off in order to build the assembled docs for verification. Run the XML validation and submit it for final review that goes straight to the grants management office for approval. All the preliminary reviewers will receive an FYI (no action is required).
How do I Login/Navigate the Temple ERA System?

Accessing the ERA System and Navigating the Main Page
This quick guide highlights the process for logging into ERA and navigating the tabs on the main page.

Step 1: Login to ERA Portal using your TU AccessNet Credentials

- Please review the “Support” section on the login page to make sure you use a supported browser and follow the “Browser Setup Guide” to configure your browser to work with ERA.
- If you forgot your password, you can go to Temple Manage Account to reset your TU secure password.
- If you request to obtain an account in ERA, please refer to ERA FQA page for more details.
Step 2: Once you successfully login to ERA, the main page will appear on the screen.

On the left-hand side of the main page, you will find the **ERA Module Navigation Panel**, which lists all the modules within the ERA system for assisting research administration activities with both pre- and post-award processes that involve the administrative and regulatory aspects of grants, contracts, and clinical trials as well as the research compliance management. You will access each individual module by clicking the name of the module.

- **Grants and Contract Management**
  - *My Proposals and Awards Module*
    - Identification of funding opportunities
    - Proposal development and Electronic Submissions of proposals to sponsors that Grants.Gov support (Proposal Development)
    - Institutional and faculty profiles
    - Electronic approval and routing
    - Budget development
    - Cost sharing information
    - Sub-contracts tracking
    - Post Award Management (Proposal Tracking)

- **Research Compliance Management**
  - *My COI Disclosure Module*
  - *My Human Subject Module*
  - *My Lab Animals Module*
    - Regulatory protocol development and approvals including IRB, IACUC.
    - Electronic submission of protocols
    - Electronic notification of protocol status
    - Animal facilities management

In addition, the central section defaults to your **Open Action Items** that lists all the routing or workflow action items requiring your review (FYI) or approval. You can access it by clicking on the folder icon next to each individual record.
Searching for a PD/PT Proposal

This section will show you how to search for a proposal in ERA.

Option 1: Searching/Accessing proposals using the “Show/List” link

The Show/List displays proposals whose user is named as the Principle Investigator. If you are a delegate, you can also see your investigator’s records. For viewing proposals as delegate please go to the delegation section to learn how to do it.

To access the proposal, you can hover over to the folder icon underneath the Institution Number (Proposal #). Depending on your security role setting and a proposal’s current status, you may edit, view or delete records in PD by clicking on PD (Proposal Development) in the Edit or View mode. For PT (Proposal Tracking) side, as a PI or BA, you can only view the information (no edit permission), regardless of the current status of a proposal.

The option of deleting your proposal is only available when a proposal is still “Under Development”. You will lose the ability to delete a proposal in the system once it is routed for internal review. You may contact the Grants Management Office for updating a proper status for cases such as when PI decides not to go-forward with submission or when a submission is being withdrawn.

For each proposal, the following fields will be displayed on the browsing result page and you can click on the header’s hyperlink along with the “up or down” arrows (if applicable) to sort your search items:

- Institution Number
- Title
- Principal Investigator (PI)
- Proposal Type
- Account Number
- Award Number
- Requested Period start and end dates
- Awarded Period start and end dates
- Sponsor
- Department
Option 2: Searching proposals using the “Search For” link

Users’ access permission with ERA is role-based. Business Administrative staff will have access based on the pre-defined security roles assigned to their affiliated org/department. The “Search For” feature allows the user to locate previously created proposals using system predefined searching criteria. As mentioned before, depending on your security role setting, you may locate certain proposals, but not all. For example, if you are the department administrator for TUSM: CVRC, you will only be able to access/view any proposals created/submitted under CVRC. Follow the steps below to learn how to locate your records.

Step 1: Click on the “Search For”

Step 2: Enter the search criteria in the appropriate field and click on “Locate”.

You can use the wildcard (*) symbol to replace unknown values. Place the wildcard at the beginning or at the end of the entered information only in any non-progressive search fields (e.g. Title, or Proposal Number).

Run a Basic Search with the following fields

Note: click on “Show Additional Search Options” to run an advanced search.

Run an Advanced Search with the following fields

Note: click on “Hide Additional Search Options” to return to the basic search.
How do I Maintain My Profile?

Before you start to use the ERA system for managing your research activities, it is important to remember to keep your profile update to date so the accurate information can be pulled into any of your proposals or protocols. You will click on “Edit” under the “My Profile” tab on the main page to update your contact information, setup your delegation, add sponsor credentials for system to system submissions and view your training certifications. Details are described in the individual sections below.

Updating Contact Information

The General Information/User Preferences Page allows you to update your contact information. You need to make sure your name matches the name you use for research. The ERA system loads from the HR Banner payroll names, so if you are using a different name for your search, be sure to enter it here. If your email address is incorrect, please contact era@temple.edu. In addition, please make sure you update your title, phone, fax number and your primary address information with the Zip+4 and then click on “Save” to retain all the changes. You can use Add Additional Address to add multiple addresses.
Setting up Delegation by Module

The new enhanced delegate feature allows you to assign delegation access by module(s) to control what a delegate can do within each specific module. You can give your delegate:

- ‘Signature Authority’ to sign a proposal/protocol on your behalf for routing.
- Complete action items on your behalf.
- Get notified on batch communications or routing related emails.
- In addition, you can allow your delegate to view your Inbox Messages or Work Queue in the system.

Note: Please be aware that delegating an individual does not limit their access to a specific record (e.g. Protocol or Proposal). It grants access to all of your records listed in that specific module in which you are listed as a PI or an investigator.

Step 1: Select the individual profile
Click on the “Delegates” link listed on the right-hand menu of the My Profile page and then click on “Add”. You will use the progressive text search to locate the profile and click on “Select”. If you see multiple personnel listed with the same first/last name, you can verify the person’s information by reviewing his/her department information and then select the proper profile from the drop down list. Once the profile is located, you will setup your delegate access permissions to your Messages, Work Queue and Calendar.

Step 2: Add module(s) to associate with your delegate
Click on the icon to add module(s) for setting up your delegate access permission.
Step 3: Select module(s) from the drop down list.

Step 4: Setup your delegate access permissions for a selected module and save the settings once you complete the section.

Note: N/A means that the function is unavailable for that specific module.

a. Name: the name of the delegate
b. Department: the primary department of the delegate
c. Messages: provides you the option to allow your delegate to view your Inbox Messages
d. Work Queue: provides you the option to allow your delegate to view your workflow action items
e. Calendar: provides your delegate the ability to view, edit, add or delete your calendar
f. Remove: remove your delegate
g. Module Record Access: provides your delegate the permission to view or edit on the records (e.g. IRB protocol or Proposal).
h. Signing Authority (Routing): provides your delegate to sign on your behalf for approval routing.
i. Complete Action items: allow your delegate to complete your workflow action items (not available in PD module)
j. CC: on emails: provides your delegate to be notified on the following system notifications.
   • Batch Communications
   • Routing: provides your delegate to be notified on routing related approval/FYI notifications.
   • Action Items: provides your delegate to be notified when a workflow action items is sent to you (not available in PD module)
k. Delete: provides you with the option to delete an unnecessary module.
Viewing My Access Permission Granted by the Investigator

The enhanced delegate feature allows your investigator to setup your access permission by modules. This section provides you with the information to review the access permissions that you have been granted for each individual module in the system.

**Step 1: Go to My Profile > Edit > Delegates**

![Delegate Feature Image]

**Step 2:** On the “User accounts that [your name] can access” section, you can review what access permissions you have been granted by the investigator.

![User Access Permissions Table]

Viewing My Investigator’s Proposals or Protocols in ERA as Delegate

The enhanced delegate feature is module based. As the delegate, you will need to go to the individual module to view the associated information.

**Step 1: Select the module of which you would like to review the information**

Go to My Proposals and Awards or My Human Subjects > Click on the icon next to the Show List link to view/access the records.

![My Proposals and Awards Section]

![My Human Subjects Section]
Step 2: Select the investigator’s name from the list

![Image of Proposals and Awards]

Step 3: View records whose investigator is listed as the PI on the “Show/List” page.

You can hover over the folder icon to access PD or PT information. Depending on what access permission is granted to you by your investigator, you might have the view or edit access in PD (proposal development). However, PT (proposal tracking) is always in the View mode for all investigators, business administrators, and their delegates.

![Image of Proposals and Awards]

Step 4: To switch back to display your own items or other investigator’s records, you can click on the icon and select the profile from the list.

![Image of Proposals and Awards]
Step 5: View the investigator’s action items (open/completed)

You can also view the investigator’s action items if you have been given the respective permission by going to the “Action Items for...” tab on the right-hand corner of the home page.

Step 6: View the investigator’s ERA InBox Messages

You can view the investigator’s ERA email Inbox if you have been given the permission by going to the “My Messages” tab on the right-hand corner of the home page. You can use the icon to switch to different profile to view the person’s messages in ERA.
Adding NIH Commons ID in Sponsor Credentials for S2S Submission

The NIH Commons ID is required in ERA for any NIH S2S Submissions. Please follow the steps below to add it into your profile.

**Step 1: Select the “Sponsor Credentials” link and click on “Add New”**

![Sponsor Credentials](image)

**Step 2: Enter your NIH Commons ID and click on “Save” to retain the change.**

![Sponsor Credentials Detail](image)

*Note: Once you store your NIH Commons ID on your profile, the information will be available on the Personnel page of a PD record.*
Viewing Training Certifications
You will see all your training certifications loaded to the ERA system, including the name of the certification, duration interval, start/end date, along with the module information. Please note that certifications cannot be deleted or added via this page.

Step 1: Select Certifications and Trainings under My Profile
How do I Create a PD Proposal?

Creating a S2S (System to System) Proposal (NIH)
S2S Proposals refer to all federal submission mechanisms that Grants.Gov supports, which will require submitting a proposal directly via the ERA system as S2S submission, except National Science Foundation (NSF). The proposal submission package (template) varies based on the sponsor's guideline and requirements. This quick guide will give you the step by step instructions for initiating a NIH proposal for S2S submission to Grants.Gov in the ERA Proposal Development (PD) module.

Step 1: Create New Proposal in My Proposals and Awards

Step 2: Confirm if you are the PI of this project
If you, as department admin, set this project up for your investigator, you will click on the Change link to locate the PI's profile using the progressive text search by typing the person’s LName, Fname and then click on Select.
Step 3: Select “Create a New Proposal” and click on Continue

Step 4: Use the drop down menu to choose the “Select Grants.Gov Opportunities” or “Select from all SPIN Opportunities” option

- **Select from Grants.Gov Opportunities**: this option gives you any opportunities in the SPIN and Grants.Gov database that are S2S submissions ONLY.
- **Selection from all SPIN Opportunities**: this option includes any opportunities in the SPIN database that are both S2S and non-electronic proposal submission templates.
- **Setup Proposal Manually**: this option allows you to manually setup a proposal without an assigned funding opportunity that is used for setting up a Non-S2S submission.

Step 5: Input the Funding Opportunity Number (e.g. NIH Parent R01: PA-16-160) and click on Search to locate the Grants.Gov submission package.

**Note**: please make sure that you include the dashes for the funding opportunities numbers in order to perform a successful search.
Step 6: Verify the Funding Opportunity information and click on “Select” to build the submission package.

Step 7: Select a Proposal Type from the drop down menu

Note: Please refer to the Grants Management Office Website for more details on the definition of proposal type.

Step 8: Select a Sponsor and click on Continue
Normally, for S2S submission, the ERA system will automatically pull the sponsor information from the SPIN database so you can leave it as it is if it is accurate. Otherwise, you can click on “Select Sponsor from full list” to reset the sponsor.
Step 9: Enter Proposal’s Title and click on Continue

Step 10: Enter the Project Start and End Dates and click on Continue
You can either manually type in a date with the format of MM-DD-YY or use the calendar feature to select a date.
Step 11: Verify the Budget Periods Information and click on Continue
The system will populate the budget periods based on your project dates.

Step 12: Verify that the information entered from step 0-7 on this page is correct
- Click on Create Proposal to create a new proposal with the information entered.
- Click on Step Back through responses to edit a specific section
Step 13: Complete the “Setup Questions” page once the proposal shell is built

The Setup Questions page triggers certain tabs to be generated on the application. Therefore, you will need to complete this page in order to have the appropriate e-application setup for S2S submission. On top of the proposal shell, it contains the following important information.

1. **Proposal #:** it is generated by the system and appears on top of the left-hand corner, which you will need for re-accessing this record or for sharing it with your department administer(s) or grants management processor(s).

2. Please make sure you click on “Done” to leave the record and DO NOT close out the record by simply X out the browser, which will cause the issue of a record being locked down by you.

3. **Title of the application, PI’s name, PI’s primary associated department, and the Sponsor’s name.**

- **Submission Mechanism/Form Information:** the system will automatically default to an appropriate S2S submission template. Therefore, you DO NOT need to make any changes for this information. The rest of the questions should default to an appropriate answer; otherwise, please verify and answer all the questions in this section. You can click on the link “Get Opportunity Number” to re-grab the FOA# for resetting the submission package if needed.
• **Grants.gov Submission Information:** review the opportunity information, validation requirements, and mandatory/optional forms included in the submission package. Forms are automatically pulled in from the Grants.Gov site based on the selected funding opportunity.

![Grants.gov Submission Information](image)

• **Deadline Information:** it is critical as it drives our internal report to track the entire pre-award submission progress. Please make sure you input the sponsor’s deadline. If the sponsor does not require a hard deadline, you can input an estimated due date that you plan to have the Grants Management office to review.
  
  o **Deadline Date:** for S2S submission, this information should be auto-populated. Please review and update if necessary.
  
  o **Deadline Time:** please make sure a due time is entered.

![Deadline Information](image)

**Note:** Please ensure that the due date is up to date if it is changed.
• **General Proposal Properties**: answer all the questions based on your research requirements for this submission.
  
  o **Associated Departments**: this displays the owning organization of the proposal responsible for managing it. It defaults to the PI’s primary associated department. However, if it needs to be changed, you can use the Add option to select the proper information and mark the updated department as the primary. This field **MUST** contain the department name and **5-digit department code** (e.g. CLA: Psychology 18110).
  
  o **PI Departments**: this displays the PI’s primary associated department.
  
  o **Link to existing proposal**: this will display **None Identified** because this record is a new master record. You don’t need to link it to any other proposal if it is a parent/master record. It is used for indicating the parent proposal number for a non-competing continuation proposal (child record).

![General Proposal Properties](image)

• **PHS/NIH Related Questions**
  If you indicated that the proposal will be submitted to PHS, NIH or one of the branches of NIH, this section will appear; otherwise, it will be hidden on the setup questions page. Please answer the questions based on your search requirements for this submission. If modular budget is required for this submission, you need to answer **YES** for the question asking modular budget.

![PHS/NIH Related Questions](image)
• **Budget Setup Information**
  
  o **Program Type**: please use the drop down menu to select the appropriate program type.
  
  o **Research Activity**: please select if the majority of the research will be conducted On or Off campus. Different selection will trigger a different F&A rate.

  ![Budget Setup Information](image)

  **Note:** please refer to the [Research Accounting Website](#) in regards to the Facilities & Administrative Rates and Categories.

Step 14: Once you complete the Setup Questions page, you will click on “Save and Continue” to populate all the required tabs/forms for this S2S submission.

![Setup Questions](image)

To make any changes on the Setup Questions page, you can un-check the Completed checkbox on top of the right-hand corner.

Step 15: **SF424 (Face Page)**

1. **Section #5 – Administrative Official**: Select the administrative grant specialist who will be contacted on matters involving this application. This information is critical as the grant person you select will be notified when the proposal is routed for internal review and approval. Please make sure this section is completed before you route the proposal for internal approval. You can refer to the [Grants Management Assignments](#) to find out who is the specialist who works with the respective contract and grant liaison to submit proposals and manage awards.

![SF424](image)
2. **Section #8 – Type of Application:** make sure the correct proposal type is selected for this submission (e.g. New or Resubmission or Renewal).

3. **Section #11 – Project Title:** this is where you can update your project title.

4. **Section #14 – PI Contact Information:** please be aware that you should not change the PI by re-typing the PI's name in the FName LName fields as it will overwrite the existing person’s profile. Please make sure you click on “Change” to link the new PI information to this project using the progressive text search.
5. **Section #19 – Authorized Representative:** select the AOR as the contact person on the page.

![Authorized Representative Form](image)

**Step 16: Performance Sites (if applicable)**

Each individual performance site needs to have the following mandatory information:

- **DUNS Number**
- **Congressional District**
- **Address – zip +4 required**

If your proposal includes any sub-awardees, you will need to first add them via the PD Personnel or Budget tab and then come back to the Performance Sites to fill out the above fields to complete the tab.

For completing the rest of the sections of a S2S submission, please refer to the **Table of Content** and go to the respective topic/chapter for more details.
Creating a Non-S2S Proposal (using ESPAF)
Non-S2S proposals refer to any foundations or non-profits or industrial sponsored projects that will be submitted via paper or using the sponsor’s website (not through G.Gov) or by email. This quick guide highlights the process for creating a proposal shell for a Non-S2S proposal in Proposal Development (PD) module.

Step 1: Create New Proposal in My Proposals and Awards

Step 2: Confirm if you are the PI of this project
If you, as department admin, set this project up for your investigator, you will click on the Change link to locate the PI’s profile using the progressive text search by typing in the LName, Fname and then click on Select.

Step 3: Select “Create a New Proposal” and click on Continue

Step 4: Use the drop down menu to choose the “Setup Proposal Manually” and click on Continue
This will allow you to manually setup a proposal without an assigned Grants.gov funding opportunity.

**Step 5: Select a Proposal Type from the drop down menu**

![Screenshot of New Proposal Questionnaire]

- **Step 0:** Confirm you intend for the PI of this proposal to be
- **Step 1:** New
- **Step 2:** Please Select a Proposal Type

Select from Grants.gov Opportunities
- Select from Grants.gov Opportunities
- Select from all SPIN Opportunities
- Setup Proposal Manually

- **New**
- NIH Non-Competing Continuation
- Continuation
- Pre-Application/White Paper
- Renewal
- Resubmission
- Supplement
- Transfer
- PA CURE
Step 6: Select a Sponsor
You will use the progressive text search to locate the sponsor and click on Continue once it is selected.

Step 7: Enter Proposal's Title and click on Continue

Step 7: Enter the Project Start and End Dates and click on Continue
You can either manually type in a date with the format of MM-DD-YY or use the calendar feature to select a date.
Step 8: Verify the Budget Periods Information and click on Continue
The system will populate the budget periods based on your project dates.

Step 9: Verify that the information entered from step 0-7 on this page is correct

- **Click on Create Proposal** to create a new proposal with the information entered.
- **Click on Step Back through responses** to edit a specific section
Step 10: Complete the “Setup Questions” Page once the proposal shell is built

On top of the proposal shell, it contains the following important information.

1. **Proposal #**: it is generated by the system and appears on top of the left-hand corner. You will need it for re-accessing this record or for sharing it with your department administrator(s) or grants management processor(s).

2. Please make sure you click on “Done” to leave the record. Please DO NOT close out the record by simply X out the browser, which will cause the issue of a record being locked down by you.

3. Title of the application, PI’s name, PI’s primary associated department, and the Sponsor’s name.

4. Importance of Instructions for Non-S2S submission: the first part of the setup questions contains some important instructions. Please read through the information in order to avoid some technical issues.

- **Submission Mechanism/Form Information**: for Non-S2S submission, it automatically defaults to Temple Non System-to-System as screen template. You DO NOT need to make any changes for this information.
If this is a flow through project, you will answer “YES” to that question and then you will click on the **Change** link on the Sponsor/Template Selection pop-up window to select the originating sponsor information.

**Deadline Information:** it is critical as it drives our internal report to track the entire pre-award submission progress. Please make sure you input the sponsor’s deadline. If the sponsor does not require a hard deadline, you can input an estimated due date that you plan to have the Grants Management office to review.

**Note:** Please ensure that the due date is up to date if it is changed.
• **General Proposal Properties**: answer all the questions based on your research requirements for this submission.
  
  o **Associated Departments**: this displays the owning organization of the proposal responsible for managing it. It defaults to the PI’s primary associated department. However, if it needs to be changed, you can use the Add option to select the proper information and mark the updated department as the primary. This field **MUST** contain the department name and **5-digit department code** (e.g. CLA: Psychology 18110).
  
  o **PI Departments**: this displays the PI’s primary associated department.
  
  o **Link to existing proposal**: this will display **None Identified** because this record is a new master record. You don’t need to link it to any other proposal if it is a parent/master record. It is used for indicating the parent proposal number for a non-competing continuation proposal (child record).

![General Proposal Properties](image)

• **Budget Setup Information**
  
  o **Program Type**: please use the drop down menu to select the appropriate program type.
  
  o **Research Activity**: please select if the majority of the research will be conducted On or Off campus. Different selection will trigger a different F&A rate.

![Budget Setup Information](image)

*Note*: please refer to the [Research Accounting Website](#) in regards to the Facilities & Administrative Rates and Categories.
Step 14: Once you complete the Setup Questions page, you will click on “Save and Continue” to populate all the required tabs/forms for Temple Non-S2S submission. Temple Non-S2S Submission template contains the following tabs that need to be completed for internal review. Please refer to the Table of Content and look for specific topics on how to complete each individual section and how to route it for internal review.

- Setup Questions
  - Face Page
    - Abstract
    - Personnel
    - Budget
    - Research Plan
    - Approvals
    - Supporting Documents
    - Temple Documents
    - Finalize
Understanding Master and Child Records
The matrix shows you what proposal types are parent records and what proposal types are child records. Selecting a proper proposal type becomes critical when you initiate a PD proposal.

<table>
<thead>
<tr>
<th>Proposal Type</th>
<th>Parent/Master or Child Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Parent/Master</td>
</tr>
<tr>
<td>NIH Non-Competing Continuation</td>
<td>Child of a Parent/Master</td>
</tr>
<tr>
<td>Continuation</td>
<td>Child of a Parent/Master</td>
</tr>
<tr>
<td>Pre-Application /White Paper</td>
<td>Parent/Master</td>
</tr>
<tr>
<td>Renewal</td>
<td>Parent/Master</td>
</tr>
<tr>
<td>Resubmission</td>
<td>Parent/Master</td>
</tr>
<tr>
<td>Supplement</td>
<td>Child of a Parent/Master</td>
</tr>
<tr>
<td>Transfer</td>
<td>Parent/Master</td>
</tr>
</tbody>
</table>

Creating a Non-Competing Continuation Proposal
The process of creating a non-competing continuation and a supplement is almost identical to the way you start a new proposal through Proposal Development (PD). Be sure to choose the proper proposal type in the drop down menu to create a PD record as it drives the master-child relationship in ERA. The called master-child structure will allow you to track entire life-cycle of a grant in one place where you will see the non-competing continuation and/or the supplement for each individual year tied to the original awarded master record in the Proposal Tracking (PT) side. Below, you will find a step by step instruction on how to create your non-competing continuation and supplement in eRA@TU for eSPAF approval and routing.

The Definitions of Non-Competing Continuation and Supplement

- **NIH Non-Competing Continuation/Continuation**: The SPAF proposal is considered a continuation when the grant has been funded for the first or second year and a new SPAF needs to be submitted in order to continue being funded the next year. The SPAF also needs to coincide with any funding that the sponsor has agreed to give in terms of changes of budget amounts.

- **Supplement**: The SPAF proposal is considered a supplemental when the grant has been funded for the first or second year and additional funding is needed to further support the project.
Step 1: Locate Your Master Record

Before you create the non-competing continuation or supplements (the child record), you will need to know your existing funded proposal tracking # (the master record) in eRA@TU in order to link the non-competing continuation or supplement to the master record. A quick and easy way to search for the master record is to use the “Search For” option.

- If you know the proposal #, you can search by that number and quickly review if it is the one you looked for.
- If you don’t know the #, you can search by “Funded” status along with other criteria – e.g. sponsor or requested date to narrow down your search.

Step 2: Create New Proposal in My Proposals and Awards

Step 3: Confirm the PI’s information

If you are the DA who create this child record for your PI, it is critical that you change the PI at this step since you will need to link it to the master record once the proposal shell is built. Otherwise, you will not be able to build the master-child relationship.
Step 4: Setup the proposal shell based on the submission mechanism

- If you plan to submit a S2S supplement proposal (e.g. PAR-14-238): you will choose “Select from G.Gov Opportunities” and then search by the FOA# to locate the submission package at the later step.
- If you plan to submit a Non-S2S proposal (e.g. NIH progress report or a non-competing continuation) to any other agencies or a supplement that G.Gov does not support as S2S submission, you will choose “Setup Proposal Manually” and then manually select the proper sponsor’s name at the later step.

Step 5: Select a Proposal Type

It is very important to select the proper proposal type in order to build up the master-child relationship for the record.

- If you plan to submit a NIH progress report to an existing awarded proposal, you will choose “NIH Non-Competing Continuation”. Others, you will flag it as “Continuation” (non-NIH).
- If you plan to submit a supplement to an existing awarded proposal, you will choose “Supplement”.

![New Proposal Questionnaire](image)
Step 6: Select a sponsor using the progressive text search if you choose the option of setup proposal manually

Step 7: Enter proposal’s title, which needs to be same as the master record, and click on Continue

Step 8: Enter project start and end date, which should be one year ONLY for the non-competing continuation and supplement child record, and click on Continue
Step 9: Follow the rest of the prompts to create the proposal shell and answer all the questions on the setup questions page.

Step 10: Use the “Look Up” link to locate the funded proposal (master record) on the General Proposal Properties section

Step 11: Select the master record

Note: you can sort by Sponsor Name, ERA #, Sponsor Award #, or Title to find the record.
Step 12: Once the child record is linked with the funded master proposal, the system will generate the proposal # with the format of master/child relationship.
The first part of the child record number is your funded master record #. The second part is a system generated sequence number that does not associate with the funding years. Basically, it is just a reference number indicating this is the first, second, or third child record created from this master record (e.g. 259648-01).

Step 13: To complete the non-competing continuation for internal review, the following tabs need to be checked off.
The approval and routing process and the internal review deadline of 5 days and 2 days rule remain the same for non-competing continuations and supplements. You can refer to the Table of Content and look for specific topic/section on how to complete the tabs.

- Setup Questions
- Face Page
- **Abstract**: NIH does not require an abstract for progress reports. You can simply upload a N/A sheet to complete the section if you are submitting a NIH-non competing continuation.
- Personnel
- Budget
- Approvals
- **Temple Docs**: a completed eSPAF, detail budget worksheet, a copy of the progress report (if applicable), and all other necessary docs for internal review.
How do I Change the Associated Department of a Proposal?

Changing Proposal Associated Department

The associated department of a proposal defaults to the PI's primary department that is preloaded to ERA from HR Banner system. If the PI's academic/clinical department is different than his/her payroll department, this information will need to be updated on the setup questions page as the associated department on a proposal should reflect the “Primary” department that manages the research proposal and dictates the administrative information within the proposal. Moreover, this information is critical as it drives many internal processes, including the route setup, the access permission for department administrators/chairs, and the ORG portion of the FOAPAL string at the time of award.

Please ensure the proposal is setup with the accurate primary associated department on the setup questions page, which indicates the department responsible for managing the proposal. If it needs to be updated, please follow the steps below to update the information.

Step 1: Navigate to General Proposal Properties section of the Setup Questions tab

![General Proposal Properties](image)

Step 2: Click on Add link next to the Associated Departments

![Add associated departments](image)
Step 3: The Department screen will appear for you to locate the department.

- You can locate the department by typing its ORG code (it must be 5 digits) and then click on Select.

- You can locate the department by typing the name of the department, and then choose the proper one associated with the correct school/college information along with 5 digits, and then click on Select.

Step 4: Mark the selected department as Primary

Now, the selected department appears on the General Proposal Properties section. You will click on the Prime radio box next to the new department just added and then click on Save to refresh this change.
Step 5: The Cost Sharing pop-up will appear. You will click on OK to continue.

You should review cost sharing sources after changing the Primary Associated Department.

Step 6: Remove the original department and make sure the new department information is refreshed on the top of the proposal shell.

Step 7: Navigate to the Budget > Setup > Budget Sources page to update the department information and click on Save to retain all the changes.
How do I add Personnel and Change PI of a Proposal?

The Personnel tab lists all research personnel associated with the proposal. The Principle Investigator selected during the proposal creation process will be automatically included in the Key Personnel section. You can use the Personnel tab to add any additional personnel on your project. Please be aware that any personnel who are NOT requesting salary (e.g. Key or Non-Key Consultants or Other Significant Contributors) can ONLY be added via the Personnel tab. We suggest that you add all other research personnel with requested salary directly via the enhanced Budget tab.

IMPORTANT NOTICE

- Please DO NOT use the “Create Profile” to add any Key Personnel (Internal) on your project.
- Adding Key Personnel: ERA imports a select group of employees from Temple's Banner HR system. If you don’t find the person’s profile who is not automatically loaded into ERA, you will need to forward the ERA Account Request Instruction to the person and he/she will follow the steps to add themselves into the system. Once completed, you will be able to select their profiles and then add them on your project.
- If you cannot find the Subaward institution from the drop down list, please send a request of adding the institution to era@temple.edu along with the subaward’s name, address and website information.
Understanding the Enhanced Personnel Tab

The following are the significant changes on the personnel tab in V15.

- **Add Personnel Grid**: it defaults to hide on the personnel tab. Click on [show] to add personnel on a project.

- **Proposal Element**: this gives you an overview of the proposal structure where you will see the information for Prime institution and any subprojects or subawards associated with the project. Also, it is where you can add your subproject/subaward institutions before adding their respective personnel on the Personnel tab. Each individual subward or subproject you added will be given a unique Project ID that will be displayed on the Legend section for the purposes of tracking and future references.

- **Profile Progressive Text Search**: the Personnel Wizard and the Personnel Pick List no longer existed in this version, which eliminates the complex process of adding personnel to a project. You
can type in the person's first name or last name or with the “Lname, Fname” format to locate a profile.

- **Biosketch/CV Library is un-available in this version**: you will need to browse and upload the CV for the person.

## Understanding Personnel Types
This matrix gives you the definition of each type of personnel and shows you how to properly use them to flag any research personnel on your project.

<table>
<thead>
<tr>
<th>Personnel Type</th>
<th>Definition</th>
<th>Available on Personnel Tab</th>
<th>Available on Budget tab</th>
<th>Appears on Assembled Key Person Form</th>
<th>Appears on Assembled Budget Form</th>
<th>Require CV/Biosketch</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Key</strong></td>
<td>Personnel who contribute to the scientific development or execution of a project in a substantive, measurable way</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>PI, Co-Investigator who is being paid from the grant</td>
</tr>
<tr>
<td><strong>Non-Key</strong></td>
<td>Personnel that are defined as non-key who will contribute effort to the proposal</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>TBDs, other Temple faculty or employees who will be paid from the grant</td>
</tr>
<tr>
<td><strong>Other Significant Contributor</strong></td>
<td>Individuals who commit to contribute to the scientific development or execution of the project, but do not commit any specified measurable effort (i.e., person months) to the project. These individuals are typically presented at effort of “zero person months” or “as needed.”</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>Temple OSCs for NIH grants</td>
</tr>
<tr>
<td><strong>Consultant- Key</strong></td>
<td>Personnel that are defined as key who are associated with the proposal but will not contribute effort to the proposal</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>Collaborators and others who are key (Biosketch included) but will not be paid from the grant</td>
</tr>
<tr>
<td><strong>Consultant- Non-Key</strong></td>
<td>Personnel that are defined as non-key who are associated with the proposal but will not contribute effort to the proposal</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>Only for individuals who are responsible (as indicated by the PI) but will not be paid from the grants</td>
</tr>
<tr>
<td>Personnel Type</td>
<td>Definition</td>
<td>Available on Personnel Tab</td>
<td>Available on Budget</td>
<td>Appears on Assembled Key Person Form</td>
<td>Appears on Assembled Budget Form</td>
<td>Require CV/Biosketch</td>
<td>Examples</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------</td>
<td>---------------------</td>
<td>--------------------------------------</td>
<td>----------------------------------</td>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>External Consultant – Key</strong></td>
<td>Personnel from an external institution that are defined as Key personnel who are associated with grant but will not contribute effort to the proposal</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Consultants who are key (Biosketch Included) but will not be paid from the grant</td>
</tr>
<tr>
<td><strong>External Consultant – Non-Key</strong></td>
<td>Individuals from an external institution that are defined as non-key personnel who are associated with the grants but will not contribute effort to the proposal</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Collaborators, Consultants who are non-key and will not request any salary</td>
</tr>
<tr>
<td><strong>External Consultant – Other Significant Contributor</strong></td>
<td>Personnel from an external institution who commit to contribute to the scientific development or execution of the project, but do not commit any specified measurable effort (i.e., person months) to the project. These individuals are typically presented at effort of “zero person months” or “as needed.”</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>External UGcs for NIH grants</td>
</tr>
</tbody>
</table>
Adding Prime Personnel with Requested Salary
As mentioned before, we suggest that you add your research personnel with requested salary directly via the enhanced **Budget** tab so that you can input their requested salary and effort % right on the page. However, you can still add them via the personnel tab first and then enter the budget details on the budget tab if this is a preferred way.

**Step 1: Adding a Key Personnel with requested salary**

a) Select **Prime** > Select **Key** in the **Personnel Type** field > Locate Profile by typing the person’s first name or last name or “LName, FName” format in the **Name** field > Select a **Role** from the drop down list (e.g. Co-Investigator) > Click on **Save** once you select the profile.

b) The personnel will be listed at the page under the **Key Personnel** type section.
Step 2: Adding a Non-Key Personnel with requested salary

a) Select **Prime** > Select **Non-Key** in the **Personnel Type** field > Locate Profile by typing the person’s first name or last name or “LName, FName” format in the **Name** field > Select a **Role** from the drop down list (e.g. Other Professional – Project Coordinator) > Click on **Save** once you select the profile.

![Personnel form image](image1.png)

b) The personnel will be listed on the page under the **Non-Key Personnel** type section.

![Personnel list image](image2.png)

Step 3: Adding a Non-Key TBD Profile (Temple Personnel) with requested salary

You will need to select a TBD profile located in the personnel list using the progressive text search box. If you have multiple TBDs on your project, you can add them with different profiles (ex. TBD1 or TBD2, etc.) in order to indicate their different roles on your project. Once the profile is selected, you will need to indicate the person’s role and then click on “**Save**” to add the profile on your project.

![Personnel form image](image3.png)
Please see the below chart for the description of each individual column on the personnel tab.

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME/ROLE</td>
<td>Name of added personnel and role on the project. Click on the name to change or update profile information.</td>
</tr>
<tr>
<td>MAIL</td>
<td>This is a link to send an email to the person. You can send an email with an attached file, a proposal or a protocol.</td>
</tr>
<tr>
<td>ALERT</td>
<td>Yellow warning sign will appear if mandatory/required information is missing on the profile. Hover over the icon to view the details of what information is missing.</td>
</tr>
<tr>
<td>COI</td>
<td>Hover over the COI indicator to see the person’s current COI status.</td>
</tr>
<tr>
<td>RESPONSIBLE</td>
<td>This indicates if the person’s COI disclosure is needed or not. Use the checkbox to indicate if the person is responsible for the design, conduct or reporting of the research/project. All key personnel will have the checkbox checked by default as they are deemed responsible and should have a COI disclosure on file for the proposal submission.</td>
</tr>
<tr>
<td>ORDER</td>
<td>This is for the order of appearance of personnel in a proposal/XML – assembled doc. You can only order personnel listed within the same personnel type/group. For example, you can use this feature to show all the key personnel CVs with a certain sequence in the XML package for NIH submission.</td>
</tr>
<tr>
<td>ORGANIZATION/DEPARTMENT</td>
<td>Affiliated institution and department. For Temple University personnel, the department code should always be in the format of 5 digits. If not, please contact <a href="mailto:era@temple.edu">era@temple.edu</a>.</td>
</tr>
<tr>
<td>PERSON MONTHS</td>
<td>The average number of person months committed to the project annually. You should leave it blank on the personnel page. You can indicate a person’s month committed to a project (effort %) on the budget details page, which will be pushed back to the personnel page. This section should be information ONLY.</td>
</tr>
<tr>
<td>CV/BIOSKETCH</td>
<td>Click on the Upload Biosketch icon to upload the person’s CV. Click on the PDF icon to view the uploaded document. To delete the existing one and re-upload, you will click on the icon and then click on “Delete Attachment” to remove it. Use the browse and upload to re-upload a new one.</td>
</tr>
<tr>
<td>CURRENT/PENDING SUPPORT</td>
<td>Click on the Upload Current/Pending icon to upload the person’s current pending. Click on the PDF icon to view the uploaded document.</td>
</tr>
<tr>
<td>REMOVE</td>
<td>Click on the Remove icon to remove the personnel from the proposal.</td>
</tr>
</tbody>
</table>
Adding Prime Personnel without Requested Salary

Step 1: Adding internal personnel with no requested salary along with 0 % effort
Any Temple personnel with “no effort” (0 appointment months) can ONLY be entered through the Personnel tab. That being said, for internal personnel with no salary support but requiring bio-sketch, they need to be flagged as either “Other Significant Contributor” or “Consultant-Key” (e.g. mentor) in the Personnel Type field.

a) Select Prime > Select Personnel Type (e.g. Other Significant Contributor) > Locate Profile by typing the person’s first name or last name or “LName, FName” format in the Name field > Click on Save once you select the profile

![Personnel Type menu](image)

*Note: If you see multiple profiles with the same names please make sure you select the one with correct department code (5 digits) and TUID.*

Step 2: Adding external personnel who are Key, but not requesting any salary

a) Adding external personnel with no salary support but requiring bio-sketch, such as Other Significant Contributor or Mentors, you will first select the ‘External Consultant-Key’ or “External Consultant-OSC” in the Personnel Type field. Next, using the progressive text search to identity the external institution and then search/locate the person in the Name field. You will also need to select a project Role for the person and then click on Save once all fields are filled out.

![Personnel Type menu](image)
b) On the mini personnel profile page, please make sure that all yellow mandatory fields are completed and then click **Save** to retain all the changes.

c) If the name is not listed in the drop down, click to add an external temporary profile. Enter pertinent information and **zip code+4 digits** and then click on **Save**.
Adding Subaward Personnel
As mentioned before, we suggest that you add your subaward personnel with requested salary directly via the enhanced Budget tab. Please refer to the section of entering your subaward budget for more details.

Changing the PI of a Proposal
Please be aware that you should NEVER change the PI directly by re-typing their names on the Face Page/SF424 page as that will overwrite the existing person's profile. There are two proper ways to change PI once the proposal shell is built.

Option 1: Change the PI on the Face Page/SF424 Page
a) You will click on the “Change” link on the Principal Investigator Contact Info section.

![Change PI window](image)

a) The change PI window will appear, which has the following two options of replacing the PI. You need to choose one option and then move on to the next step.

- Replace PI and Leave the Current PI on the Proposal
- Replace and Remove the Current PI

b) Select the new PI's profile using the progressive text search and then click on Add new PI. You will see the new PI’s contact information being pulled into the face page.

![Add new PI](image)

Option 2: Changing the PI on the Budget > Setup Page
a) Go to Budget tab > Click on Setup > Click on Change PI tab

b) There will be two options of replacing the PI. Choose one from the drop down list.

c) Select the new PI's name using the progressive text search and then click on Add New PI. Afterwards, you will see the project is refreshed with the new PI's information.
How do I Enter the Budget?

Understanding the Enhanced Budget Model in V15
The three different type of budget models in V13 have been consolidated into one in order to streamline data entry in V15. The quesiton on “What kind of budgeting model would you like to use” has been elminiated in V15 on the setup questions page.

- **V13 View**

- **V15 View**

7 Significant Changes in the V15 Enhanced Budget Model

1. The first thing you will notice once accessing the budget area is that it displays in an enhanced summary page that **allows you to enter the personnel and budget details in the new modal pop-up window**. The new budget page is the combination of the Budget Summary and Detailed Budget. Therefore, the “Summary budget” tab that we used to see in V13 for any S2S submission packages without using the “RR_Budget” form (e.g. PA-16-130 or HRSA grants) will no longer be needed in PD. All budget data should be entered in the Budget page.

2. You can **view budget breakdown by different sources** (e.g. Sponsor v.s. Project). If there is any cost sharing on the project, you will see the breakdown totals for each source in this section.

3. You can **export ERA full budget details** to Excel.
   - You can Import or Export Grants.Gov Budget Form (Adobe forms budget).

4. You can **build RR_Budget Adobe PDF form** on the budget tab before assembling the entire package.

5. There will be no more tab to tab completion sequence. The system allows users to move between various tabs of the budget in any order and there will be only one **Complete Budget** button to check off the entire budget in PD. Please be aware that the budget numbers will not be pushed to the eSPAF until you click on the “Complete Budget” link.

6. You can use “**Add Bulk Entry**” to add up to 5 non-personnel costs in one place. You can use it for multiple times.
7. Add **Subawards** or **Subprojects** budgetary information and the related personnel on the budget tab.

The screenshots below illustrate where the items have been moved from V13 in V15 on the Budget Details page.

- **V13 View**

- **V15 View**
**Entering Itemized Detail Budget Costs**

This section highlights the process for entering budget for direct and indirect costs in the budget tab. After clicking on “Budget” on the navigation menu, the enhanced budget modal pop-up window will appear for entering the budget details for all periods on this page.

### Entering Budget - Direct Costs

#### Step 1: Entering your Personnel Costs

**Option 1: Entering your personnel costs via the “Detail” tab.**

- Go to “**Personnel**” section of the Budget tab and click on the “**Detail**” icon next to the person’s name (e.g. PI role).

- The **Personnel Costs Detail** page will appear.
• Enter the person’s “**Base Salary**” and the “**Person Months**” detail in the appropriate appointment type field (*Calendar = 12 months, Academic = 9 months, Summer = 3 months*). The **Salary** field for each period will auto-populate based on these data entries.

![Image](image-url) 

**Note:** once you entered the details for the first budget period, the same information will automatically flow down to all subsequent years. If you want to modify an individual period with a different base salary and/or person months, you will need to hit the “**Save**” icon first and then go to each individual field for that year to make the appropriate edits. By doing so, the updated budget for that specific period will not be automatically pushed down again to the next period.

• Click on the **icon next to the Fringe Benefits** field to select a proper employee category for the person (e.g. Gov’t Agreement-FT or All Others-PT).

![Image](image-url) 

• Once it is selected, the fringe benefit amount will be calculated based on the rate applied. On the screen, you will see what type of category is being used for the fringe calculation. You can click on **“Show Calculation Details”** to see how the requested total is calculated. To move on to the next item, click on **“Save and Close”**.

![Image](image-url)
Option 2: Entering your personnel costs via the “Appointments” tab.

This option allows users to complete the budget at the project level. Period calculations for the entire project are automatically completed, allowing for more accurate effort timeframes to be used when determining timeframes and effort on the project.

First, you will need to fill out the Salary/Payroll information section, which consists of the following fields:

a) **Add Appointment**: start with adding a single appointment or multiple appointments.

b) **Appointment Type**: select the appointment type (e.g. Academic or Summer).

c) **Appointment Start/End date**: these dates define the length of time during which the entered salary is applied. The appointment cannot be saved without these dates being entered. They should align properly with the project dates as it will affect the requested salary calculation.

d) **Base Salary Amount**: enter the amount of money the person makes per the appointment period in the base salary.

e) **Fringe Benefits Scheme**: the fringe benefits scheme selected in the pick list will calculate the Fringe Benefit Amount based on the determinants defined within the setups. If the preferred rate is not available you can use the manual entry option to indicate the total fringe benefit amount.

f) **Net Salary**: this amount represents the total Base Salary + Fringe Benefit Amount for each appointment.

g) **Primary**: if additional appointments have been added, you may select which appointment is the primary for period calculations.

h) **Delete**: if additional appointments have been added, you may remove appointments by clicking .
i) **Salary Radio Button** (there are three options): select a radio button to **Continue** salary past appointment end date, **Recycle** salary on the annual anniversary (respecting effective dates), or Salary **Ends** on the Appointment end date. If you hover over to the radio button you will see the detail descriptions of each option.

**Note:** *If a person only shows a single 12-month appointment, the first two radio buttons will produce the same result.*

- If you choose to **Continue the Salary Past the Appointment End Date**, then an appointment(s) can be entered for a given timeframe. The salary associated with this appointment will continue to be extrapolated beyond the actual appointment start and end dates.
  - **For example:** *If a person shows a single calendar appointment and the salary is expected to increase with a standard inflation, then this is the option you should consider.*

- If you choose to **Recycle the Salary on the Annual Anniversary (respecting effective dates)**, then the appointments are recycled or reused for future periods. This option would be a likely choice when you want to show an academic and summer appointment, and the salary is expected to increase with a standard inflation.

- If you choose to **End the Salary on the Appointment End Date**, then the system will not extrapolate the salary appointments and the salary will not be recycled. This option is helpful in prime and subcontract budgets when the anticipated salary in outyear(s) cannot be determined by a standard inflation rate.

j) **Annual Inflection:** this inflection scheme may be selected independently for each item within the budget.

k) **Apply inflation on the Primary Appointment Anniversary Date:** the inflation will be applied on the Primary Appointment Anniversary date for this person if this checkbox is checked; otherwise inflation will be calculated according to what is selected on the Budget Setup screen to either apply inflation based on the scheme dates or on the project anniversary dates.
After completion of the “Appointments” tab, you will need to indicate how many person months involvement there will be for each period on the “Details” tab. You can switch to the “Effort” option for entering the effort % for each period. Click on “Save” to calculate salary and fringe benefits. This is required because appointment data is being used. You can click on “Show Calculation Details” to view how the person’s requested budget is being calculated. Click on “Close” once this is complete.

Step 2: Add additional personnel with requested budget

To add additional personnel with requested budget, you will go back to the Budget Summary screen and follow the steps below to add the individual into the budget.

- Select the person’s profile by using the progressive text entry field.
- Indicate the personnel type: Key or Non-Key.
- Select the person’s role on the project via the drop down list.
- Click on Add Person.

- Repeat Step 1 for entering the person’s requested budget details.
Step 3: Entering your Non-Personnel Costs

As mentioned before, V15 has a feature that allows bulk entry (5 entries) in one setting for non-personnel costs. Click on **Add Bulk Entry**, then a screen will open for data entry.

**Note:** “Add Bulk Entry” can be used multiple times for entry of more than 5 categories. The system also allows for single entry if it is a preferable method.

First, you will select the **Sponsor Budget Category** from the drop down list, then the corresponding information will appear for selection. Enter the description and total costs for each period and then click on **Add** once all entries are completed in the bulk entry page.

When a Sponsor Budget Category (e.g. Supplies) is selected multiple times, the costs will be collapsed into one category and the number of entries will be listed beside the budget category. You can click on the “**Detail**” link to view the itemized information.
**Entering Budget - Indirect Costs**

On the **Prime F&A** tab, you may modify the F&A Scheme along with your Comments, Base, and Rate if the default rate does not match the sponsor's F&A requirement of the proposal. If you re-select any of the predefined schemes/rates from the drop down list, please make sure that the **Institution Base/Target Scheme** is also updated to match the scheme so the drift will not appear on the F&A tab. Click on “Apply” to refresh the calculation once the correct scheme is selected.

If the sponsor requires an F&A Rate (indirect rate) that is not pre-populated in the scheme drop down list, the rate can be modified by using the **Manual Entry** method.

- **Scheme**: leave it blank
- **Base**: select MTDC
- **Scheme Rate**: select “Manual Entry” (click on the pencil icon to add your comments)
- **Rate**: enter the Sponsor's allowable rate and then click on **Apply**
You can also use the “Manual F&A” to manually enter the F&A total for each line item or for the entire period using the F&A breakdown section. Once it is completed, you will click on Save on the top left-hand corner to retain the changes.

Entering Modular Budget (NIH)
The modular budget only applys to NIH submissions. On the Setup Questions Page, select Yes for the question of “Will this proposal be using a modular budget”? Once this is setup, the “Modular Budget” tab will appear under the Budget tab.
When you first open the budget, it defaults to **10 modules** (based on $25,000 increment(s)) with the direct costs of $250,000 for each period. If the detailed budget entry and the budget based on the selected numbers of modules does not match, then the variance will be listed in the *Modular Budget Transaction section* by each project period at the bottom of the Budget page. As you enter detail budget, the adjustment will change to always match that difference.

The F&A calculation is based on the detailed budget. In the example below, it is calculated by the MTDC of $247,820, excluding the tuition fees.

---

**Modular Budget Transaction**

$250,000 (Requested Direct Costs (Personnel Costs + Non-Personnel Costs))

For example - **Period 1**:

$250,000 - ($206,720 + $11,000) = $32,280

---

**F&A Breakdown**

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Subcategory (Indirect Cost Type)</th>
<th>Rate</th>
<th>Base Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-01-2017</td>
<td>01-31-2017</td>
<td>Implementation On Campus</td>
<td>30.00</td>
<td>247,820.00</td>
</tr>
<tr>
<td>2</td>
<td>01-01-2018</td>
<td>01-31-2018</td>
<td>Implementation On Campus</td>
<td>30.00</td>
<td>247,820.00</td>
</tr>
<tr>
<td>3</td>
<td>01-01-2019</td>
<td>01-31-2019</td>
<td>Implementation On Campus</td>
<td>30.00</td>
<td>247,820.00</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>743,460.00</td>
</tr>
</tbody>
</table>
The Modular Budget page will display the requested budget amount and F&A. You will select module for each period to ensure what you have requested (detail budget) is closer to the modular budget ($25,000 increments). The gap will reflect the difference between the modular and detail budget. It should be kept to either 0 or a negative number. The final total on the modular budget page will be populated to the “Estimated Funding” (#15) field on the SF424 page.

<table>
<thead>
<tr>
<th>Year</th>
<th>Direct/Indirect Costs F&amp;A</th>
<th>Modular Budget</th>
<th>Amount</th>
<th>Gap</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>248,067.00</td>
<td>205,800.00</td>
<td>3,867.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>249,097.00</td>
<td>205,800.00</td>
<td>3,867.00</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>249,097.00</td>
<td>205,800.00</td>
<td>3,867.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>748,061.00</td>
<td>629,400.00</td>
<td>8,001.00</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Detail Budget</th>
<th>Indirect Costs</th>
<th>間緊急宗</th>
<th>Total Budget</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>248,067.00</td>
<td>205,800.00</td>
<td>3,867.00</td>
<td>205,800.00</td>
</tr>
<tr>
<td>2</td>
<td>249,097.00</td>
<td>205,800.00</td>
<td>3,867.00</td>
<td>205,800.00</td>
</tr>
<tr>
<td>3</td>
<td>249,097.00</td>
<td>205,800.00</td>
<td>3,867.00</td>
<td>205,800.00</td>
</tr>
<tr>
<td></td>
<td>748,061.00</td>
<td>629,400.00</td>
<td>8,001.00</td>
<td>629,400.00</td>
</tr>
</tbody>
</table>

**Estimated Funding on the SF424 Page**
**Entering a SubAward**

To add a subaward, click on “Show” next to the **SubAwards** section of the **Budget** tab, then begin by typing the subaward’s name using the progressive text search. Once the subaward has been added, you will locate the personnel from the drop down list and then click on “Add Subaward”. If a person is not found, click on “Add New Profile” and then enter the pertinent information for the sub PI or any additional personnel. The Zip Code field must have entry of the **zip code + 4 digits**.

Once the subcontractor’s PI has been selected, the screen below will appear. If the PI will participate for all the project periods, then click on “Save”.

If the sub’s PI will not participate in one or more budget periods, then click on “Add to Period” and the budget periods will appear. Uncheck the period(s) that the sub’s PI will not participate and click X to exit the screen, then click on “Save”.

---

**Table and Figures:**

- Table showing subawards with columns for Inst/Contractor Name, Order, Short Form, Period 1, Period 2, Period 3, and Direct Costs.
- Figures illustrating the process of adding a subaward and managing participation periods.
The period(s) will then be noted with a red flag to indicate the *inactive* budget period(s).

Click on the “**Detail**” link to enter the budget details for the subaward and add any additional personnel within the same page. To add any other subwards, you will begin by typing the name of the institution in the name field. Afterwards, you will select the sub-PI’s profile from the drop down list and then click on “Add SubAward”.

Click on Detail to add any additional personnel to this existing subaward and enter the budget details for direct and indirect costs and cost sharing (if applicable).

To add any additional subawards, you will begin by typing the institution name from here to locate the subaward and then select the personnel from the drop down and click on Add subaward.
Entering the budget details for the subcontractor is the same as how you enter the budget for the Prime, except that it has a SubAwards watermark in the background, reminding you of which budget screens you are on.

**Step 1: Entering your Subaward Personnel Costs**

You will first click on the **“Detail”** link next to the person’s name and then the Personnel Costs – the Detail tab will appear for salary data entry. You will enter the base salary, person months, and fringe amount for this person. After that, click on **“Save and Close”**.

*Note: you can review how the budget total is calculated by clicking on “Show Calculation Details”.*
When adding additional personnel to the same subaward, first you need to select the person using the progressive text search. Once the profile is located, you will need to select the Personnel type (Key or Non-Key), the Person’s Role on the project, and then click on the “Add Person”. If the person is not found, then click on “Add New Profile”. All pertinent information, i.e. Name, Title, Email, Phone, Address, zip + 4 digits, Department are required. Once data entry has been completed, you will click on “Save” to retain all the changes.

Step 2: Entering the Non-Personnel Costs
When adding the non-personnel costs, you can use “Add Bulk Entry” to enter up to 5 non-personnel items at one time, or you can add a single one by selecting the budget category from the drop down list and then click on “Add Item”. The Non-Personnel Costs screen will appear for entering the details. You can apply the Annual Inflation for calculating the subsequent years. Make sure you have detail information entered in the Description field for review. Once it is complete, click on “Save and Close” to retain all the data entry.
Step 3: Entering the Subaward F&A Amount

If F&A details information is required, click on next to the **Project F&A**, then the F&A breakdown screen with the budget periods will appear. Enter the Indirect Cost Type, Rate, Base, then the system will calculate the F&A amount. Otherwise, you can simply enter the F&A total amount for each period in the summary buckets.

Once the information is entered, click **Save** on the top left-hand corner and the F&A amount will be populated in the Project F&A buckets.
If a proposal has multiple subawards, the number will be listed next to the SubAwards sections. The top section of the Budget page will provide the budget summary data for different budget sources. You can click on "Show" next to the sponsor to view the breakdown.
Import or Export Grants.Gov Budget Form

The **Import/Export Adobe Forms Budget** button is displayed at the top of the **Budget Summary** page for both Prime and Subaward entities. Please note that it is ONLY for importing or exporting the **Grants.Gov Adobe Forms**. It is not for the purpose of importing or exporting your internal/departmental budget excel worksheet.

**For importing Grants.Gov Budget Form**, it is normally used for importing your **Subaward(s) Adobe Budget Form(s)** that is given by each individual subaward. This way, you can simply import the completed Grants.Gov Adobe Budget Form instead of manually adding the subaward(s) and then entering their budget details into the application. Importing the prime budget is unnecessary as you can simply input our budget details directly via the budget tab of the application.

[On the Individual Subaward Budget Summary Page]

![Image of Individual Subaward Budget Summary Page]

**For exporting Grants.Gov Budget Form**, this is used for the scenario when we are the subaward institution and it is a federal flow through project. For instance, University of Pennsylvania is our primary sponsor and they are getting the awards directly from a federal sponsor (e.g. NIH). In this case, we can complete our budgetary information in the PD application, and then export the details for generating the Grants.Gov Adobe Budget Form for the prime sponsor to compile the Grants.Gov submission package for S2S submission.

[On the Prime Budget Summary Page]

![Image of Prime Budget Summary Page]
Importing Adobe RR_Budget Form for Subaward

Step 1: Select a Subaward Institution, Sub-PI, and then click on “Import”.

You can also click on the “Import/Export Grants.Gov budget form” icon to import the adobe budget form if the subaward is already added to the list.

Step 2: “Browse” the Subaward's Adobe RR_Budget Form and click on “Upload”.

Step 3: Map the budget periods and personnel/departments to those in the application.

- **Requested Periods**: map the budget over to the individual year using the drop down list.
- **Personnel Mapping**: first person in the list will replace sub-PI selected during subaward setup. If the person’s profile is not available in the subaward/consultant database, you will leave the option of “Add New” for the both Name and Department columns.
- **Non-Personnel Costs Mapping**: select a proper budget category for each individual item.
- **Processing the Mapping Screen**: click on the Process icon on top of the subawardee import page. Any existing personnel/line items and values will be replaced with the information from the Adobe Form.
Exporting Adobe RR_Budget Form for Prime

Step 1: Click on the “Import/Export Grants.Gov budget form” icon to export the budget details to Adobe Budget form.

Step 2: Click on “Export” to Adobe for the specific G.Gov opportunity number.
**Entering Cost Sharing**

The Cost sharing is an optional tab where the detail information is not required to be filled out in the PD Budget. However, it is mandatory to be disclosed in the “**Cost Sharing Agreement**” e-form embedded in the eSPAF under the Temple Documents section of the PD application for the purpose of internal review. If you prefer to add the cost sharing into the Budget – Cost Sharing tab, you will follow the steps below to complete this section.

**Step 1: Click on “Detail” next to each line item for entering the breakdown**

![Detail Button Example]

**Step 2: Enter the cost sharing details for each period on the breakdown page and click on “Save and Close” once it is complete.**

Enter the cost sharing percent in the **Percent** field under **Sponsor**, **Institution**, and/or **Unallowable**. Salary and Fringe Benefits costs will calculate based on the percentage entered. If the combined percentage entered in these three columns does not equal 100% for that budget period, the percentage total will be highlighted in red and it needs to be corrected before saving the information.

![Budget Detail Example]
Uploading the budget justification

In the **Justification** tab, you will use the “**Browse**” icon to select the budget justification document and then click on “**Upload**”.

Exporting Budgets

You can **export** ERA full budget details into Excel by clicking on the excel icon on the top of the Budget Summary page. The full budget spreadsheet contains the following sub-tabs:

- Summary of the budget with direct and indirect costs
- Labor costs breakdown including the fringe benefit amount
- F&A breakdown including the F&A rate applied for each period
- Cost sharing breakdown
- Effort % details for each personnel
Budget Setup

There are two new NIH S2S related features available in the “Budget Setup” page that will allow you to validate the budget before completing the entire submission package.

- The “Mechanism Opt In/Out” tab allows you to remove any non-applicable program validations right on the budget page. Therefore, you don’t need to un-complete the setup questions page to make this change.

- The “Budget Validate” option is specific for “NIH related S2S submission” that allows users to validate the budget before assembling the XML package. A pop-up warning might appear to point out all the budget validations for correction.
Changing the Project or Budget Start/End dates on the Period Dates tab

To Change the project start and end dates, first you need to verify the budget periods to make sure that they are generated correctly. You can Add or Remove budget period on this page. Once it is confirmed, you can enter the “New Start Date” in the “New” field to refresh the project period and then click on the “Save” icon on top left-hand corner to save the changes.

Budget Sources

The budget sources define the recovery costs for the proposal. By default, there will be three sources displayed on this page:

- **SRC 1**: the sponsor referring to the funding agency: this is defined at the top of the Setup Questions screens with the proposal sponsor.
- **SRC 2**: the source of non-sponsor cost-sharing (institutional cost sharing).
- **SRC 3**: the source of recovery for non-allowable costs (unallowable cost sharing).
Complete Budget and Build PDF

Once you complete the budget piece of a proposal, you will click on the “Complete Budget” tab to check off the entire budget section, which will make the tab as view only along with a statement in red “You are in view only mode due to the budget being completed.” By doing so, the budget summary level information (Direct/Indirect/Subaward) will be generated on the eSPAF for internal review. Please be aware that the budget needs to be completed before submitting a proposal for internal review. Also, before you assemble the entire S2S submission package on the finalize tab, you can build RR_Budget Adobe Form for S2S submissions on the budget summary tab by clicking on the “Build PDF” icon, which gives you a quick review of the details of the Adobe budget form at the time of completing the budget tab. If there is any error or budget changes are needed, you will click on “Un-Complete Budget” to release the budget tab for modifications. When you re-completing the PD budget, you will see a system message indicates that the PD budget will overwrite any existing data in the PT personnel/budget. You will click on OK to move on to check off the budget.

Once the budget is completed, please make sure you click on “Done” to exist out the page.
How do I Upload Documents?

Uploading Internal Documents for Electronic Routing and Approval

The **Temple Documents** section is where you will upload all the internal documents for review that will not be transmitted to the funding agency. The mandatory eSPAF is the electronic version of the sponsored Project Approval Form (SPAF). It has been simplified and reviewed for consistency. Much of the information on the eSPAF is carried into the esPAF as your proposal is developed in ERA. Things such as the Setup Questions, SF424 (Face Page), Personnel, Budget and Approvals (IRB, IACUC, EHRS) must be completed before starting the eSPAF. Currently eRA supports the eSPAF and routing for all Federal, S2S, and Non-System-to-System submissions including NSF and any federal announcement that specifies a paper submission.

Uploading Required Internal Documents for Review

Please be sure to add the following documents in this section before you submit the proposal for internal review.

- The **Completed** Compliance and Commitments Form (eSPAF)
- Your full budget worksheet with account code
- Program Announcement, Required Forms
- Sponsor Guideline regards to indirect
- Subrecipient Commitment Form (if applicable)
- Subcontracts with scope of work, LOI, Budget and Justification (if applicable)

You will use the “**Add Institution Forms/Supporting Documents**” link to upload any internal documents required for internal review.
You will do the following steps when uploading a new document:

- Input the name of the document
- Browse and add the document
- Select a proper category from the drop down list
- Click on the “Upload” icon

Completing the eSPAF for Internal Review

To update the eSPAF, you will click on the “Edit” icon and then the eSPAF form will appear for completion.

Please make sure you click on “Save” if you exit out the e-form without checking it off as completed; otherwise you will lose the data you entered on this page. There are some highlights listed below:

- All the fields with * are mandatory, which means you must answer them for completing the e-form.
- Once you complete the e-form, you will check off the “Complete” checkbox. You can un-check it for any edits before submitting for internal review.
• **Requested Budget Details:** the data is mapped directly from the PD Budget tab. Please be aware that you have to click on “Complete Budget” in the PD Budget tab, which means you check off the entire budget piece in order to populate the budget information in this section. The data cannot be edited directly via this page. You will need to go back to the “PD Budget” tab for any budget modifications. The updated budget will automatically be mapped over to the dynamic eSPAF once you click on “Complete Budget” on the PD Budget tab. However, the built PDF version will not be updated unless you un-check the “Complete” checkbox on the e-form and then check it off again for rebuilding the PDF with the latest information.

• Depending on your answer, you might be asked for more detailed information for some questions. For example, if you answer “YES” to the Question of “Does your project involve human subject?” You will need to use the “+” sign to indicate the HS protocol status and number. At the time of proposal submission, the status of your protocol can be pending, but it needs to be approved at the time of award.
Uploading documents to an NIH Proposal

This section highlights the process for uploading documents in an NIH proposal (e.g. R01). Please make sure you read through the sponsor’s guideline and follow their instructions on where to upload the required documentations within the application as the information may vary depending on what funding opportunity you are going to submit for.

Resizing your PDF document for NIH Submissions

For NIH submission, all uploaded PDF documents must be 8.5”x11”. Any document that does not match this size will receive an error when uploaded:

To resize your PDF document, please follow the steps below. Please note that you will need the Adobe Acrobat Pro version to do so.

Step 1: Open the PDF file

Step 2: Go to File > Print > Choose the Name of Printer: Adobe PDF (Print PDF to PDF)
Step 3: Remove the checkbox of the following two items to change the page size of the PDF to 8.5”x11” and then click on OK to print the resized PDF file.

- Choose Paper Source by PDF page size
- Print to File

Step 4: Check the page size of the PDF file

- Close the original PDF file and open the resized PDF file
- Go to File > Properties > Verify whether the page size is 8.5”x11
**Uploading Project Summary**

On the project summary tab of a NIH proposal, you will click on “Browse” to select the file and then click on “Upload”. Please be aware that upload documents must conform to NIH Standards.

Once it is uploaded to the tab, you can view the document in PDF version or in original file version and then check off the “Completed” checkbox. If you need to make any edits, you can un-check the completed checkbox, and then click on the “Remove” button to delete the document and then re-upload it.
Uploading Project Narrative and Other Attachments

Uploading a document in these two sections of a NIH proposal, you will first click on the tab (e.g. Project Narrative), click on “Browse” to locate the document and then click on “Upload”. Please be aware that upload documents must conform to NIH Standards. All uploaded document will be automatically converted to PDF.

Once it is uploaded, you can view the document in PDF version or original file version. If you need to re-upload it, you can click on “Replace” to browse the new document and then upload it again. Please make sure you check off the “Completed” checkbox once the document is successfully uploaded.
Uploading PHS 398 Research Plan Documents

To upload a document to the PHS 398 Research Plan tab, you will click on the “Upload” icon next to the individual section and then the “Upload Attachment” pop-up screen will appear for you to browse the document and to upload it to the specific section.
You can view the document in either PDF version or original file version once it is uploaded. You can click on “Replace” to re-upload the document. Under the “Complete/Composite Proposal Body” section, you will see one consolidated PDF document which combines all the attached documents within the PHS398 Research Plan tab. Please make sure you mark it as “Final Version” once it is ready for submitting the final review and check off the “Completed” checkbox.
How do I attach protocols in a PD proposal?

Approval tab is where you upload specific approvals for protocols such as human subject or lab animals. As a PI, you are required to attach all your IRB or IACUC protocols (if applicable) in the “Approvals” tab prior to routing proposal for approval.

**Step 1: Click on “Add” to attach your protocols**

![Add Approvals](image)

**Step 2: Add an “Attached” protocol into your PD proposal**

If you are attaching a protocol that has been created in the “Human Subject” or “Lab Animal” module, you can choose the “Attached” option and link it to your PD proposal. Please note that the “Attached” feature can only be used for HS and LA modules in ERA. All other types of protocol (e.g. EHRS, or Biosafety) will be added to your PD proposal using the “Not Attached” option.

1) Choose the **Approval Type** using the drop down menu (e.g. Human Subjects).
2) Choose the **Attached** option and click on “Continue”.

![Add/Edit Approvals](image)

3) Locate the HS Protocol by entering the protocol number and clicking on “Go”. You can also use the “Browse By” option to search for the protocol.

![Add Human Protocol](image)

4) Once it is located, you will scroll down to the bottom of the page to select it.
5) You will see the protocol is being attached to the "Approvals" tab with detailed information. Since this protocol is linked directly via the Human Subject module, you will not be able to edit the details.

Note: if you submit a S2S submission, the “Approval Date” of the highest sequenced HS and/or LA protocol will be mapped to Other Project Info.

Step 3: Add a “Not Attached” protocol into your PD proposal

If a protocol has been submitted to the IRB or IACUC office for approval, you can use the “Not Attached” option to add a Pending protocol at the time of your grant submission.

1) Choose the Approval Type using the drop down menu (e.g. Human Subjects).
2) Choose the Not Attached option and click on “Continue”.

3) Choose the status of “Pending” and click on “Save”.
How do I submit a proposal for Internal Review?

Temple Internal Review Requirements and Submission Deadline

Grants Management Office recommends all grant, contract and subcontract proposals be submitted to their office at least 10 business days prior to deadline date of the funding agency. All external sponsor projects must have a deadline date and arrive to the Grants Management Office for final approval through the ERA system. Proposals must comply with the following two internal deadlines; otherwise a waiver request needs to be sent from your Dean to the Vice President for Research Administration, Dr. Michel Masucci for approval. Proposals requiring the 5 or 2 day waiver are not guaranteed on-time submission; however the Grants Management Office will make every effort to submit it. Please download the “Best practices when working with Grants Management” for more details.

- For Preliminary Review: the signed “Administrative Portions” of all grant and contract proposal materials need to be submitted for review. The following 8 tabs of a PD record need to be marked as completed along with the required information in ERA before submitting for review. The preliminary routing and approval process needs to be completed no less than 5 full business days prior to the sponsor deadline.
  - Setup Questions
  - SF424 or Face Page
  - Project Summary or Abstract *(If it is not required by the sponsor, please provide a brief summary of the project.)*
  - Personnel *(CV or Other Pending Support)*
  - Performance Sites with DUNS, Zip+4
  - Budget and Budget Justification
  - Approvals *(IRB, IACUC, IBC, EHRS)*
  - Temple Documents
    - eSPAF *(completed version)*
    - Your full budget worksheet with account code
    - Program Announcement and required Forms
    - Sponsor Guideline regards to indirect
    - Subcontracts with scope of work, LOI, Budget and Justification *(if applicable)*
    - Subrecipient Commitment Form *(if applicable)*
    - Request for Principal Investigator Status Form *(if applicable)*

- For Final Review: the entire proposal needs to be completed including your scientific/scope of work narratives and be submitted for review and approval no less than 2 full business days prior to the sponsor deadline. All the tabs within a PD proposal need to be marked as completed before submitting for final review.
Submitting Proposal for Preliminary Review

When you have completed the mandatory tabs in ERA and also completed the eSPAF, you may submit the proposal for preliminary review. Please be aware that the Personnel and Budget tabs need to be fully completed before submitting for preliminary review as they will be locked down, which means you will not be able to modify the information once it is submitted for routing. If any significant modifications are required, the reviewers can return the proposal back to the PI/Department Administrator for modification and re-route it for internal approval. Otherwise, you will need to contact the Grants Management Office for further assistance.

During the approval process, as the PI or DA, you can only edit the scientific/scope of work narratives/research plan, and/or any sponsor required documentations/S2S forms sections. This allows routing to begin while the PIs and their colleagues are still working on the science portion of the proposal. The PI and all Key Personnel as well as their chairs and DAs are requested to review the proposal through ERA online dashboard. After the departmental approvers complete their reviews, the proposal is routed to the Dean’s office of the key personnel on the proposal for approval. Finally, depending on the sponsor’s type of the proposal, the development office may be required to review the proposal before the pre-review route is complete.

A Standard “Preliminary Review Route” Contains the Following Steps

<table>
<thead>
<tr>
<th>Routing Step</th>
<th>Routing Personnel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>FYI Grants Management Office</td>
</tr>
<tr>
<td>Step 2</td>
<td>Key Personnel Sign Off (e.g. PI/Co-Investigator)</td>
</tr>
</tbody>
</table>
| Step 3       | FYI DAIII (PI’s department administrator who is assigned with DAIII role.)  
   Note: they can be the ones who build the proposal for the PI, but no approval action is required on the route. |
| Step 4       | Departmental Approval (the respective DA, Chair from the key personnel’s department) |
| Step 5       | Dean's Office Approval (the respective Dean or Associated Dean from the key personnel's department) |
| Step 6       | Development Office Approval (Conditional Setting)  
   Note: their approval is not required for any federal, city/county, state, college/university, clinical trials contract and contract records. |
| Step 7       | FYI Conflict of Interest Office |
Step 1: Click on the “Submit Pre-Review” thumbs-up icon on Temple Documents tab

The system will automatically pick up the proper pre-review route based on the “primary associated department” information indicated on the setup questions page. For example, P-EDU (P: refers to preliminary; EDU: refers to the name of the school/college which is college of education in this case.)

Step 2: Read the certification and check off the “Accepted” box and click on “Continue”.

Step 3: Click on “Submit” to process the route

**Note:** please DO NOT close the processing window until the operation has finished. If you see incorrect personnel listed on the routing path please contact eRA@temple.edu for changes.
Finalizing and Submitting Proposal for Final Review

After the proposal has completed the preliminary review route, its status will be changed to “Preliminary Review Complete”. As a PI or Department Administrator, you will receive a system notification indicating that your proposal has completed preliminary approval routing and is ready to be finalized and submitted to Grants Management Office for final approval. The final review will go directly to the Grants Management Office for review. All the pre-reviewers will receive an information notification (FYI) indicating that the proposal is routed for final review.

A Standard “Final Route” Contains the Following Steps

<table>
<thead>
<tr>
<th>Routing Step</th>
<th>Routing Personnel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>FYI all the pre-reviewers</td>
</tr>
<tr>
<td>Step 2</td>
<td>Grants Management Office Approval</td>
</tr>
</tbody>
</table>

Finalizing your S2S Submission

Step 1: Finalize your proposal on the finalize tab

Before finalizing your proposal, you need to ensure research plan tab is marked as “Final Version” and all the tabs of a PD record need to be completed along with a check mark.
Step 2: Go to the “Finalize” tab and click on “Build” to generate PDF/Form Pages

<table>
<thead>
<tr>
<th>Form Page</th>
<th>Last Built</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF424 (R&amp;R)</td>
<td>Building</td>
</tr>
<tr>
<td>Other Project Info</td>
<td>Building</td>
</tr>
<tr>
<td>Performance Sites</td>
<td>Build Complete</td>
</tr>
<tr>
<td>Personnel</td>
<td>Build Complete</td>
</tr>
<tr>
<td>PHS398_Fund_RiskPlan</td>
<td>Building</td>
</tr>
<tr>
<td>Budget</td>
<td>Building</td>
</tr>
<tr>
<td>PHS300_CoverPageSupplement</td>
<td>Building</td>
</tr>
<tr>
<td>PlannedReport</td>
<td>Building</td>
</tr>
</tbody>
</table>

**Note:** once these pages are built, uncompleting any of these “Tabs” will require that you re-build these pages.
Step 3: Click on “Build Grants.Gov Application” to generate the assemble application

Note: please do not close the processing window until the assembled doc is successfully built.

Step 4: Click on “Submit Final Review” on the finalize tab

Step 5: Read the certification and check off the “Accepted” box and click on “Continue”.
Step 6: Click on “Submit” to process the route

Please do not close the processing window until the “Active Routing Progress” page is generated.
Finalizing your Non-S2S Submission

Step 1: Finalize your proposal on the finalize tab
Before finalizing your proposal, you need to ensure research plan tab is marked as “Final Version” and completed. All the tabs of a PD record need to be completed along with a check mark ✔.

Step 2: Go to the “Finalize” tab and click on “Build” to generate PDF/Form Pages

Note: please do not close the processing window until the system completes building all the PDF/Form Pages. Once these pages are built, uncompleting any of PD tabs will require that you re-build the pages.
Step 3: Build the “Assemble Application”

You may re-order the sequence of the files first and then click on “Build” to generate the assemble application. Please do not close the processing window until the assembled doc is successfully built with a time stamp and PDF document.

![Build PDF / Form Pages](image)

Step 4: Click on “Submit Final Review” on the finalize tab

![Submit Final Review](image)
Step 5: Read the certification and check off the “Accepted” box and click on “Continue”.

![Certification Image]

Step 6: Click on “Submit” to process the route

Please do not close the processing window until the “Active Routing Progress” page is generated.

![Routing Progress Image]
Reviewing Proposals Using the Online Dashboard

As a reviewer, you will be notified for approving a proposal via email notification and via routing action items. The email notification along with instructions will be sent to both your TU email account and your ERA Message Inbox. The routing action item will be located under “My Open Action Items” section once you login. You will use the “Online Reviewer Dashboard” embedded in the approval notification to sign off a proposal or to directly login to ERA to access the dashboard via My Action Items.

Step 1: Access the reviewer dashboard

Example of Proposal Approval Notification

The approval email notification includes an embedded link to “Reviewer Dashboard”. You will click on it to perform your review.

Example of My Open Action Items

The routing action item is also sent to your Open Action Items section. Once you find the proposal # that you are going to review, you will click on the folder icon to access the reviewer dashboard.
Step 2: Click on the “Review” tab to perform your review

Step 3: Review the attached forms and indicate a review status for them
All the items attached under the “Temple Documents” tab of a PD record will appear on this section for review as well as the entire PD proposal. You can click on the link of each individual form/document to open up the proposal or documentation that has been uploaded under the Temple Docs section. The first item is always the PD proposal that you can review all the components within the application including personnel, budget and etc. You will need to indicate your review status for each individual form/document using the drop down list. Once the status is updated for each line item, you will need to click on “Save” to retain all the changes and then move on to the next step.
Step 4: Add your comments for the review
You can add your comments to the review. There are 4 options: you can share your comments with everyone, or between you and the PI, or between reviewers only, or between you and Admins. Please make sure you click on the “Save” icon to retain all the information.

Step 5: Use the drop down menu to make your decision on this proposal
There are four options: Approved, Approved with comments, Revisions Requested or Not Approved.

Please note that if you disapprove the proposal by selecting either “Revisions Requested” or “Not Approved”, the proposal will be returned back to the PI for modifications. The PI will receive a notification indicating that the proposal has been returned by the reviewer for a revision to be made. As a reviewer, you can utilize the comments textbox mentioned above to write down the required changes so that the PI or BA(s) can review your comments and then follow the comments made in the dashboard to modify the proposal for re-approval. The PI will revise the proposal and then resubmit it to the electronic route once again. The route will start again from the beginning. For minor changes, we suggest that the reviewer should contact the PI and/or business administrator(s) and discuss the changes to be made. After the revisions are made, the reviewer can simply approve the proposal to move it on to the next step.
Step 6: Accept the review certification

Please read through the certification and then mark it as “Accept”. Once all the items are reviewed and a decision is made for this project, please make sure you click on “Save” on the top right-hand corner to save the review. Without saving it, the review will be neither recorded nor completed.
Step 7: Review the active routing progress on the dashboard
You can click on the “Route” tab to review the active routing progress page. By looking at this page, you can see where the item is in route and who is holding up the review. Also, you can see the review decision made by each individual reviewer. If you hover over to the decision column, you will see the “completed date”, indicating when the reviewer signed off on it. The “notified date” is not a decision date; it simply indicates when the reviewer(s) received the notification, which can be a FYI (information only) or an “Approval Required” message.
Reviewing the Comments and Resubmitting the Proposal for Approval

As a PI, you will receive the notification email with the subject of "Please review comments regarding your Proposal" when the reviewer(s) disapproves your proposal. The same notification will be forwarded to your business administrator(s) and the Grants Management Office to make them aware of that the proposal has been returned back to the PI for revision. You will need to login to ERA to review the comments and resubmit it for routing once revision is complete.

Step 1: Open the proposal using the “Open submission Package” Link

On the notification, you will see the “Proposal #” along with the “Open Submission Package” link, which allows you to open your proposal directly by clicking on it.

<table>
<thead>
<tr>
<th>Proposal #: 239609</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title: Coordinated Care for Knee Pain and Effect on Physical Function and Healthcare Utilization</td>
</tr>
<tr>
<td>Sponsor Name: NATIONAL INSTITUTES OF HEALTH/DHHS</td>
</tr>
<tr>
<td>Deadline: 02-Sep-2016</td>
</tr>
</tbody>
</table>

Please review the comments left by the reviewers here: [Open Submission Package]

Click here for a brief documentation on how to review the comments in the routing process.

Click here for brief instructions on how to resubmit your proposal for review.

Step 2: Review the comments made by the reviewers

Once you open up the proposal, you will go to the respective pages for reviewing the comments.

- For **Preliminary Review**, the details of where it is in the route, the approval status, and the reviewer's comments will all appear on the “Temple Documents” tab of a PD proposal. You will click on the “Scroll” icon to view the comments along with other details.

For **Final Review**, the details of where it is in the route, the approval status, and the reviewer’s comments will all appear on the “**Finalize**” tab of a PD proposal. Please click on the “**Scroll**” icon to the comments along with other details. You will need to scroll down to the bottom of the page to view the latest route history information.
Step 3: Revise the proposal and resubmit it for approval

Once you revise the proposal based on the comments from the reviewer, you will need to re-route it for review.

• For resubmitting the “Preliminary Review”, you will click on the “thumbs up” icon to resubmit the proposal back to pre-review on the “Temple Documents” tab.

![Temple Documents](image1)

• For resubmitting the “Final Review”, you will click on the “thumbs up” to resubmit the proposal back to final review on the “Finalize” tab.

![Finalize](image2)

How does PD validate the submission package?
The PD submission validations only appear when using an electronic submission template, not available when using a Temple Non-S2S submission template.

**Attachment Filenames Validation**

Attachment filenames feature will validate filename characters and trigger a warning message if any uploaded documents contain a filename over the sponsor’s limit. In addition, it also allows you to rename the filename on the fly to correct the error without going back to the individual tab for replacing the documentation with an updated name.

**Validation warning for “filename cannot be over 50 characters long”**

If an uploaded file has 50 or more characters for G.Gov submission, the system will throw you a warning on the finalize page with a yellow triangle icon that you can hover over to view the details. To correct it, you will click on the “Attachment Filenames” link and click on “Edit” to change the file name right on the page and then click on “Save” to retain all the changes. After that, the warning message will disappear on the finalize page.
Renaming an uploaded document's filename

Step 1: Click on the “Attachment Filenames” link on the finalize tab
Step 2: Click on the “Edit” link next to the file name column to rename your file.

**XML Validation**

You can run the “**XML Validation**” to verify if the final build application, which will be submitted to the agency, has met the agency submission requirements. You should complete the XML validation before submitting the proposal to Grants Management Office for final approval. If everything has “passed”, it means that the submission package has included all the agency requirements. The offering sponsors may have their own validations in place that will be checked at the moment when the application is being retrieved and validated by the sponsor, which is not part of the XML validation process in ERA.
Validating uploaded documentation in the submission package

XML validation will verify any uploaded documents to ensure that they have met the agency requirements. For instance, if a document contains bookmarks, you will see the following pop-up warning message reminding you to check the sponsor's guideline and ensure that the formatting of documentation is acceptable by the agency. If change is needed, you will need to remove any unacceptable formats in the PDF and then re-upload it to the respective PD tab. Once it is done, you will need to rebuild the PDF/FORM pages on the finalize tab and then run the XML validation again to verify if the error is corrected.

Validating submission package components and each individual forms included in the application

XML validation ensures all the required forms are included in the package by verifying the information pulled from Grants.Gov on the setup questions page. It also validates the individual forms. If everything has “PASSED” with a green checkmark, it means that the application has met the agency's submission requirements. Otherwise, you will see “FAILED” along with detail error messages. If error occurs, you can contact era@temple.edu for assistance by providing us the error message along with screenshot(s) and proposal number. Once it is fixed, you can continue to submit your proposal for final review on the finalize tab.
**NIH Commons Validation**

This option is only available for NIH applications, not for any other federal submissions. Running the NIH Commons Validation will check the application package against the NIH Commons electronic validation rules prior to submitting the application to Grants.Gov. Errors and Warnings where appropriate and desired can be corrected prior to submitting the internal review (Final Route) on the finalize tab.

The result page contains the following information:

- **Date/Timestamp**: the date/time you run the validation
- **Result**: validation result indicator. It could be either “warning” or “error”.
- **Description**: the description of a warning or an error message.
- **Grant Image**: if the application contains no errors, the grant image will be built and you can click on “View” to review the final grant image that will be generated once NIH retrieved the application in ERA Commons.
• **Delete Image:** if you run the validation more than once and there is more than one grant image will be built. You can delete a version that is built previously. However, the latest one will not be able to be removed.

Please be aware of the fact that the result page will display ALL the validation attempts accumulating every validation you have submitted. In other words, it is a cumulative page of validation results of every single attempt. The prior information will not be overwritten by a new attempt.

**Submitting the NIH Commons Validation:**

On the finalize page, click on “Submit” to run the NIH Commons Validation. By doing so, it will validate the application and check the application package against the NIH Commons electronic validation rules.

- **Case One: No Errors/Warnings**
  If you receive this type of information after running the NIH validation, it means that the application is ready to be submitted to the Grants Management Office for final approval and submission.

  ![NIH Commons Validation Table](image)

  **Note:** You can click on “View” to review the final grant image that will be generated in the NIH commons side.

- **Case Two: No errors, but warnings**
  If you receive this type of information after running the NIH validation, please check with the Grants Management Office to confirm if the warning needs to be fixed for this submission as it varies depending on the RFA and sponsor’s requirements.

  ![NIH Commons Validation Table](image)

  **Note:** You can click on “View” to review the final grant image that will be generated in the NIH commons side.
Case Three: Errors and Warnings
If you receive this type of information after running the NIH validation, please correct the errors prior to submitting the application to the Grants Management Office for final review. If you are unsure how to fix the errors, please contact the Grants Management Office for assistance.